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Introduction 
This document describes the installation procedure for the Myeloma System Server (MSS), Myeloma System 
Administration Console (MSAC), QuickScan Touch plus (QST) client and the QSTplusbackup software.  The 
QST plus system can be installed in multiple configurations. The MSS, MSAC and QSTplusbackup software’s 
are intended to be deployed on the same server computer, while the QST client may be installed on the 
server, or any other Windows PC computer on the same network as the server. 
 
There are four different scenarios for the QuickScan Touch plus installation. 
 

1. For a new system with prerequisites, (see Preparation for MSS / MSAC Installation) follow the 

instructions in section System Software Installation and Backup software installation to install MSS, 

MSAC, QST plus Client and QSTplusbackup.  Once installed, follow the instructions in the System 

Configuration to configure the database and Server. Lastly, refer to Legacy Data Import section to 

import the setup, Worklists and QC scans from QST 1.3.9.0 version.   

 

2. For a new system with prerequisites (see Preparation for MSS / MSAC Installation) and Helena 

provided database (i.e. Database file is provided by Helena), follow the instructions in section System 

Software Installation and Backup software installation to install MSS, MSAC, QST plus Client and 

QSTplusbackup. Once installed, follow the instructions in the System Configuration to configure the 

database and Server and then follow the Database Restoration section. Lastly, refer to Legacy Data 

Import section to import the setup, Worklists and QC scans from QST 1.3.9.0 version.   

 

3. For the installation of the QST plus client software only (i.e. for a pathologist’s computer), use the 

following: 

 

a. Appendix B – IIS Installation (Windows 10 Pro) or 

b. Appendix E – Verification of Existing IIS Installation(Windows 10 Pro) 

c. Appendix J – Verification of .NET Framework Installation 

d. QuickScan Touch plus Client Installation (Paying attention to step 11 for setting up the IP 

address).  

 

4. For an existing system, where the software (MSS, MSAC and QST plus client) only needs to be updated 

with the currently released version, follow the instructions in Appendix K.  

Important notes before beginning the update: 

 All clients must be logged off (no longer accessing the database) before the updating process 
begins. This includes all pathologist client systems, which might remotely access the system.  

 All Helena software must be updated to the same release version. Varying QST plus client 
versions that are not compatible with the MSS version can causes serious issues. Mixing old 
and new software versions on the same network are not supported. 

 Be sure to update QST+ on each client computer before opening the program once the update 
process has begun.  
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Notes for IT When Installing a QST+ System 

IP Address 

The QST plus server computer must be given a static IP address so client computers can locate them on the 
network. 

Admin Rights During Installation 

During installation of the QST plus to the system, admin rights need to be given for needed serial number to 
be written to the registry. Once the system is installed on the network, users and rights can be created as 
needed by the institutions IT department.  

System Locale 

If the QST plus system is being operated outside of the United States, the language for non-Unicode 
programs will need to reflect the applicable locale for the desired language and date format to be displayed 
in the QST+ client. 
Refer to Appendix H to make this change to the client computer(s). 

Preparation for MSS / MSAC Installation 
The Myeloma System Server installation requires the following hardware and software: 
 
1. A computer with Windows Server 2016 (with desktop experience) or Windows 10 Pro 

2. Microsoft Internet Information Services (IIS) v10 

3. PostgreSQL 10.1 

Appendix A through Appendix D detail the installation of all prerequisite software. 
 
Refer to Appendix E through Appendix G to verify or trouble shoot the installed software. 
 
The same administrative user must be used to complete the installation of all prerequisite software. 
 
The QuickScan Touch plus client requires Windows 10 Pro.  
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System Software Installation 

MSS Installation 

1. Double click the Myeloma System Server Setup file (MSS.msi) to start the installer.  Click “Next”. 

      
 
2. Click “Next”. 

      
 
3. Click “Install”. 
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4. If there is a “User Account Control” popup displaying text as “Do you want to allow this app from an 

unknown publisher to make changes to your device”, click “Yes” to continue. 

5. Once installation is complete, click “Finish”. 

        
 
6. A browser window pops up displaying Myeloma web page indicating installation of MSS is successful. 

Close the browser window. 
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Note: if a HTTP Error 500.19 appears instead of the localhost/Myeloma/ page, refer to Appendix J to 

verify installation of .NET Framework.  

 

MSAC Installation 

1. Double click the MSAC Setup file (MSAC.msi) to start the installer.  Click “Next”. 
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2. Click “Next”. 

       
 
3. Click “Install”. 

       
 
4. If there is a “User Account Control” popup displaying text as “Do you want to allow this app from an 

unknown publisher to make changes to your device”, click “Yes” to continue. 

5. Once installation is complete, click “Finish”.  The MSAC will launch automatically.   
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6. Refer to “MSAC Configuration” section to run the MSAC. 
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QuickScan Touch plus Client Installation 

1. Double click the QuickScan Touch Setup file (QuickScan Touch plus.msi) to start the installer.  Click 

“Next”. 

        
 
2. Click “Next”. 

       
 
3. Click “Install”. 
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4. If there is a “User Account Control” popup displaying text as “Do you want to allow this app from an 

unknown publisher to make changes to your device”, click “Yes” to continue. 

5. Once installation is complete, click “Finish”.  

       
 
6. Right Click the “QuickScan Touch plus” desktop icon and select “Run as administrator”.  
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7.  If there is a “User Account Control” popup displaying text as “Do you want to allow this app from an 

unknown publisher to make changes to your device”, click “Yes” to continue. 

8. If installing on a new system, or if the previous QST plus Client program data folder was deleted, an error 

message appears. 

       
 
9. Click “OK”. QST plus client loads ‘localhost/myeloma’ as the SQL server URL by default. If the QST plus 

Client is installed on a separate PC from the SQL server, an error will appear. 
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10. Click “OK”. The QST plus Client prompts for SQL server URL. 

       
11. If the QST plus Client is installed on a Windows PC other than the server, type in the IP address of the 

server followed by the word “/myeloma”. For example, if the IP address of the server is 192.168.1.53, 

then the SQL Server URL will be “192.168.1.53/myeloma”. Click “Connect” 
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12. If the QST plus client is installed for the first time, it prompts for serial number, type in the serial number 

and click “OK”. 

Note: if the QST plus client is being run on a SPIFE Nexus instrument, it will need to be serialized through 

the SPIFE Nexus software. 

       
 
13. Login as Helena user by typing the username as “Helena”. Calculate today’s password using the formula 

8423714 + today’s date in the form of MMDD.  For example, if today is 12/15, the password would be 

8423714 + 1215 = 8424929. Type the calculated password and click “Sign In”. 
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14. For enabling V8 and Myeloma software options, select “Help” from the Main menu, then click “About”. 

       
 
15. Enable “V8 Capillary Electrophoresis System Interface”. Type in the Authorization key, which is Helena 

user’s password followed by the number 8656 and click “OK”. 
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16. Enable “Myeloma” option, type in the Authorization key, which is Helena user’s password followed by 

the number 8269 and click “OK”. 
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17. Click “OK”, then “OK”. V8 and Myeloma options are successfully enabled in the QST plus client software. 
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Database Backup Software  

Installation  

QSTplusbackup software can create a database backup file. Following are the instructions for the installation 
of the tool.  

1. Double click the QSTplusbackup setup file (QSTplusbackup.exe) to start the installer.  

2. The installer checks for .NET Framework 4.8 before installing the software. When not found, it 

prompts the following window. Click “Next”. 

 

 
 

3. Click “Next”. 
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4. Accept the license terms and Click “Install”. 
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5. The installer begins the .NET Framework setup.  
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6. Before completion, the installer checks for any open program in the system. If available, it instructs 

the user to close the program. Press “Yes”. 

 
 

7. Once installation is complete, click “Finish”. 

 
 

8. After installing .NET Framework, the installer begins to install the backup software. Click “Next”. 
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9. Click “Next”. 

 
 

10. Click “Install”. 
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11. If there is a “User Account Control” popup displaying text as “Do you want to allow this app from an 

unknown publisher to make changes to your device”, click “Yes” to continue. 

12. Once installation is complete, click “Finish”. 
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Database Backup 

Once the installation is complete, follow the instructions for backing up the database.  
Please create two database backup files one on the Server PC and another on the flash drive. 
Before running a backup, ensure that all users log out and close the client software. 
 

1. Double click the QSTplusbackup desktop icon. A QSTplusbackup window appears. 

         
 

2. From the ‘Options’ drop-down menu, select ‘Backup Database'. 

        
 

3. A ‘Save As’ window appears. Select the folder where the backup file is to be created and click “Save 
As”.  
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4. A progress bar indicating the database being backed up appears. A window will pop up after a 

successful back up. 

        
 

5. A window with the message ‘Database successfully backed up!’ will pop up after a successful back 
up. 
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6. Click “OK” to close the message box. Then select “Close” to close the software. 

Automation of Database backup 

Important note: The automatic backup process will create regular database backups at the frequency of your 
choice; when creating a new backup file, the automated task will store up to 10 backup files at the location 
thereby deleting any older backup files to make space for the recent files. As an example: the scheduler could 
be set to create a backup of the database every day at a specified time (as shown below). Over time, this will 
create 10 backup files; each day a new file would be created and the oldest stored file would be deleted. 
 

1. Double click the QSTplusbackup desktop icon. A QSTplusbackup window appears. 

         
 

2. From the ‘Options’ drop-down menu, select ‘Schedule Backup'. 

 

  

 
3. A ‘Schedule Backup’ window appears with most features being greyed out. Click the ‘Enable 

scheduled backup’ checkbox and the features should no longer be greyed out. 
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4. Firstly, choose a location to save the backup files by clicking the ‘>’ button near the bottom right of 

the window. 
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5. Choose a Time Schedule between Daily, Weekly and Monthly and set the time for the backup to 

start.   

 
 

6. Click OK and the main QSTplusbackup window should update with ‘Backup Type’ and ‘Next Backup’ 

information. 

 

Once you've completed the steps, it'll run automatically on the schedule you specified. 

Database Restoration 

 
1. Double click the QSTplusbackup desktop icon. A QSTplusbackup window appears. 
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2. From the ‘Options’ drop-down menu, select ‘Restore Database’. 

 
 

3. An ‘Open’ window pops up and pick the .backup file you want to restore. 
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4. Click ‘Open’ and wait for the program to restore the database. A progress bar indicating the same will 

appear on the main QSTplusbackup window. 

 
 

5. Once the database is restored, a pop window confirming the same will appear. 

 
 

6. Click “OK” to close the message box. Then select “Close” to close the software. 

 
 

Existing Software Uninstallation 
1. Open the Control Panel and click Programs, then Programs and Features on the Server PC, and double 

click the Myeloma System Server software. If prompted, click Yes. Myeloma System Server software 

uninstallation is complete. 

2. Double click the Myeloma MSAC software on the Program and Features window and click Yes, if 

prompted. Myeloma MSAC software uninstallation is complete. 

3. On the Client PC, open Control Panel>Programs>Programs and Features. Double click the QuickScan 

Touch plus software and click Yes. If prompted, click Yes. Repeat this step for uninstalling QST plus 

software from every client PC. 

4. Ensure that all the existing applications are uninstalled successfully. 
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System Configuration 

PostgreSQL Configuration 

Ensure the PostgreSQL is “Running” as follows 
 

1. To determine the current PostgreSQL state (“Running” or “Stopped”), open a “Computer 

Management” window.  “Computer Management” is found in the Windows Start Menu inside the 

“Windows Administrative Tools” folder. 

2. Inside the “Computer Management” tool in the left pane, expand “Services and Applications”, 

followed by “Services”.  Click “Services”.  Find in the right pane displays “postgresql-x64-10” and its 

state.  If the state is “Stopped”, right click on “postgresql-x64-10” and click “Start”. The status will 

change to Running. 

 
 

 
 

3. Close the Computer Management Window. 

MSAC Configuration 

1. Open the MSAC application. 

2. Calculate today’s MSAC password. 

The formula is 8423714 + today’s date in the form of MMDD.  For example, if today is 12/15, the 

password would be 8423714 + 1215 = 8424929. 

3. Enter the password and click “Login”. 
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4. If the server has been previously configured (in the situation of a system upgrade), skip to step 9 

below. Otherwise, click “Get MSD Info”.  Since the server has not been configured previously, default 

values will be populated for the database name, server name, and the authentication. 

          
 
These are the default values: 
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Note: currently, the MSS only supports the “Windows Authentication” mechanism for connecting to the 
database server.  Even though the “User Name” and “Password” fields have values populated, when 
“Windows Auth” is checked, these values are ignored. 
 

5. Click “Set MSD Info” to save this configuration in the MSS. 

6. Click “Reset MSS”.  This action forces the MSS to load the newly saved configuration file. 

            
 

7. Click “Get User Names” (found in the bottom right corner of the MSAC window).  This action creates a 

database in the database server per the “MSD Database Name” field and populates all of the MSS 

tables. 

            
 

8. After a few moments, the default user name list is displayed as follows: 

           
 

9. Click “Get MSS State”.  If the value “READY” appears, the MSS is correctly configured and the 

corresponding POSTGRE database is fully operational: 
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10. Click “Logout” and close the MSAC application.  Configuration is now complete. 

Legacy Data Import 

Import Legacy (QST 1.3.9.0 version) Setup 

Note: using the following instructions to import the Setup files from QST 1.3.9.0 (legacy) will not import the 
“Import / Export” settings (LIS), nor the “Sample Handler” settings (ESH). If the same settings are required for 
the new QST plus system, it is advised to record those settings via screenshot before dismantling the legacy 
system. 
 

1. Open the QST plus client software and login as Helena user by typing the username as “Helena”. 

Calculate today’s password using the formula 8423714 + today’s date in the form of MMDD. Type the 

calculated password and click “Sign In”. 

 
 

2. Select FileImport LegacyImport Setup option. 
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3. Import Legacy Setup window appears.  

    
 

4. Ensure that the QST 1.3.9.0 setup files are stored in C:\Program Data\Helena Laboratories\QuickScan 

Touch\Setup folder. If not, choose the folder where the setup files are stored and then click “OK”. 

5. Confirm Import message box appears. Click “Yes”. 
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6. Import Setup message box appears. Click “OK”. 

     
 

Legacy Setup Import is complete now. 

Import Legacy (QST 1.3.9.0 version) Worklists 

1. Open the QST plus client software and login as “Helena” user. 

2. There are three different options for importing legacy Worklists. 

a. Importing Original only Worklists 

This option can be used when importing Original only Worklists from QST 1.3.9.0 version. It is 

available in the QST plus client only when Myeloma software option is not enabled. 

Following are the instructions: 

1. Make sure that the Myeloma Software option is disabled in the QST plus Client. 
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2. Select File->Import Legacy->Import Original Only Worklists option. 

  
 

3. Import Legacy Worklists window appears. 

        
 

4. Make sure that the 1.3.9.0 Original Worklists are available in the C:\Program Data\Helena 

Laboratories\ QuickScan Touch\Worklists folder. If not, choose the folder where the legacy 

Worklists are stored and click OK. 

5. A progress bar appears. 
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               Importing Original Only Worklist is complete now. 
 

b. Importing Myeloma(both Original and Review\Accepted\Reedit) Worklists 

This option can be used when importing both Original and Myeloma Worklist from QST 1.3.9.0 

version. It is available in the QST plus client only when the Myeloma Software option is enabled. 

Following are the instructions: 

1. Make sure that the Myeloma Software option is enabled in the QST plus Client. 
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2. Select FileImport LegacyImport Myeloma Worklists.

 

3. Confirm Import dialog box appears.  

        
 

4. Click Yes. Import Legacy Worklists window appears. 
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5. Make sure that the 1.3.9.0 Original and Myeloma (Review/Accepted/Re-Edit) Worklists are 

available in the C:\Program Data\Helena Laboratories\ QuickScan Touch\Worklists folder. If 

not, choose the folder where the legacy Worklists are stored and click OK. 

6. A progress bar appears. 

        
 

               Importing Myeloma Worklists is now complete. 

c. Importing Original to Accepted Worklists 

This option can be used for importing scans of Original Worklist (QST 1.3.9.0 version) as Accepted 

scans. It is available in QST plus client only when the Myeloma Software option is enabled. 

Following are the instructions: 

1. Make sure that the Myeloma Software option is enabled in the QST plus Client. 

        
 

2. Select FileImport LegacyImport Original-to-Accepted Worklists. 
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3. Confirm Import dialog box appears. 

        
 

4. Click Yes. Import Legacy Worklist window appears. 
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5. Make sure that the 1.3.9.0 Original Worklists are available in the C:\Program Data\Helena 

Laboratories\ QuickScan Touch\Worklists folder. If not, choose the folder where the legacy 

Worklists are stored and click OK. 

6. A progress bar appears. 

        
 

                    Importing Original to Accepted Worklists is complete now. 

 

QC Scans Import 

Following are the instructions for importing QC scans from QST software 1.3.9.0 to new QST plus software. 
 

1. Copy all the files from the folder C:\Program Data\Helena Laboratories\QuickScan Touch\QC. (NOTE: 

be sure to include the “QC.TDF” file in the QC folder. This is the QC index file; if it is not copied to the 

new location, QuickScan Touch plus will not display the legacy QC scans.) 

              
 

2. Paste the above files in the file location C:\Users\Public\Helena Laboratories\QuickScan Touch 

plus\Program Data\QC.   
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Import of QC scans into the new software is complete. 
 

Bulk Accepting Scans from Original Worklists 
Following are the instructions for accepting scans from original worklist 
1. Login as Helena user. Select File-->Open and press F1. “Transfer....Accept” option appears on the screen. 
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2. User can either select a Worklist or click “Select All” and then click “Transfer...Accept” or they can 

simply select “Transfer…Accept” option. 

 
 

 

3. Transfer Worklist from Original to Accepted window appears. 

 
 

4. User can select either Transfer Selected option or Transfer option.  

 

5. When user selects “Transfer Selected” option, QST plus transfers only selected Worklist. Transfer 

Worklist from Original to Accepted window disappears once the process is finished. 

 

6. When user selects “Transfer” option, a message box appears informing the user the total number of 

Worklist in database. 
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7. Click OK. QST plus starts to transfer scans from Original Worklist to Accepted state. Transfer Worklist 

from Original to Accepted window disappears once the process is finished. 
 

All scans from selected Worklist(s) are transferred to Accepted state.  
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Appendix A – Windows Server 2016 Installation 
 
*** Only follow this instruction set if using Windows Server 2016 as the server machine for MSS *** 
1. Boot the computer using installation media. 

2. When prompted with the “Windows Setup” screen, click “Next” 

         
 
3. Click “Install Now” 

        
 
4. Enter the license and click “Next” 
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5. Select “Windows Server 2016 Standard (Desktop Experience)” and click “Next” 

       
 
6. Check “Accept License Terms” and click “Next” 
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7. Click “Custom: Install…” 

        
 
8. Select an empty hard disk for installation and click “Next” 
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9. Windows will take several minutes to copy files and install.  Once complete, set an administrator 

password when prompted. 

10. The installation is now complete. 
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Appendix B – IIS Installation (Windows 10 Pro) 
1. Open the Windows Control Panel and click “Programs and Features”. 

 

2. Click “Turn Windows features on or off”. 

         
 
3. Ensure the following selections are enabled in the “Windows Features”. 

 
 

4. Scroll down to “Internet Information Services” and select it. The box will fill with a black rectangle. 

Expand to “Internet Information Services” -> “Web Management Tools” and enable the following check 

boxes. 
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5. Expand “Application Development Features” and enable the following checkboxes. 

 
 

6. Expand “Common HTTP Features” and enable the following checkboxes. 
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7. Expand “Performance Features” and enable the following checkboxes. 
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8. Expand “Security” and make sure to check the following boxes. Click “OK” to start installation.

 

 
9. Once the installation is complete, a dialog displaying “Windows completed the requested changes” 

appears.  Click “Close” to dismiss the dialog.  

       
 
10. IIS is now installed successfully. 

11. Close the Control Panel window. 
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Appendix C – IIS Installation (Windows Server 2016) 
1. Launch “Server Manager” from the start menu.  Click “Add roles and features”. 

      
 
 

      
 
2. On the “Before You Begin…” page, click “Next”. 

3. Click “Role-based…” and click “Next”. 
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4. Select the current server (should already be selected by default) and click “Next”. 

       
 
5. Select “Web Server (IIS)”.  On the IIS features dialog popup, select “Include management tools…”, and 

click “Add Features”. 
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6. Back in the “Select features” window, click “Next”. 

       
 
7. Click “Next”. 

8. Ensure at least the following selections are made in the “Role Services” and click “Next”. 
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9. In the “Confirmation” stage, click “Install”. 

10. In the “Results” stage, ensure “Installation succeeded on…” is displayed and click “Close”. 
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Appendix D – PostgreSQL 10.1 Installation 
(For Windows Server 2016 or Windows 10 Pro) 

 

1. Run the installer (double click the “postgresql-10.1-3-windows-x64.exe”) and click “Yes” to begin 

installation. 

 
 

2. Click “Next” on each installation screen. When the “Password” screen is displayed, enter “postgres” as 

password then click “Next”. 

      
 
3. Click “Next” on each installation screen.  

4. Click “Finish” to complete the installation. 
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5. If “Stack Builder” popup displays, click “Cancel”. 

Appendix E – Verification of Existing IIS Installation (Windows 10 Pro) 
1. Open the Windows Control Panel and click “Programs and Features”. 

2. Click “Turn Windows features on or off” 

     
 

3. Scroll down to “Internet Information Services”.  The box should be filled with a black rectangle. Expand 

to “Internet Information Services” -> “World Wide Web Services” -> “Security” and make sure the box 

next to “Windows Authentication” is checked, if not, check the box. Click “OK”. 
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Appendix F – Verification of MSS Installation  
1. Open an Internet Browser  

2. Enter http://localhost/Myeloma in the address bar to launch the Myeloma website 

 

 
 

3. To access Myeloma APIs, click “Swagger” at the top of the web page to display 

MyelomaSystemServer page. 

http://localhost/Myeloma
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4. Click “MSS” to display MSS APIs. The display should be similar to the following. 

               
 

5. Close the browser. 

Appendix G – Troubleshooting MSS Installation (Windows 10 Pro) 
1. Run Internet Information Service (IIS) Manager 

a. Right click Windows icon and select “Run” to open Run Dialog 

b. Type in “inetmgr” then click “Ok” to start IIS Manager 
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2. In the panel on the left, navigate to Myeloma, then click “Basic Settings” at the right panel. 

 

 
 

3. The “Edit Application” popup displays. Check the Application Pool for Myeloma is “Myeloma 

AppPool”.  Click “Cancel” to dismiss the popup. 
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4. Verify “Myeloma AppPool” is installed with .Net v4.0 

a. Click “Application Pools” in the panel on the left 

b. A list of Application Pools displays 

c. Check .Net CLR Version for Myeloma AppPool, .Net CLR version should be v4.0 
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Appendix H – Local Region Format Configuration 
The following steps must be performed on the QST plus client computer(s) to ensure the correct regional 
date format and non-Latin script is displayed in the QuickScan Touch plus system. 
 
Note: changing the language in Windows does not translate the contents of QuickScan Touch plus. 
 

1. Open “Control Panel” and click “Clock and Region” (the “Settings” app in Windows 10 does not have 

the necessary setting). 

 

 
 

2. Then click “Region”. 
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3. In the “Region” window, select the “Administrative” tab, then click “Change system locale”. 

 

 
 

4. In the “Region Settings” window, select the desired locale from the dropdown menu (e.g. “English 

(Australia)”) and click “OK”. 
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Note: if the desired language does not use a Latin based alphabet (e.g. Korean), then additionally 

enable the “Beta: Use Unicode UTF-8 for worldwide language support” option. Do not enable this 

setting if it is not needed, since it may cause certain characters to be displayed incorrectly elsewhere 

in Windows. 

 

 
 

5. Restart the PC. This setting makes region changes for non-Unicode programs; simply changing the 

region settings in the Windows 10 “Settings” app is not entirely system-wide. 

Below is an example of date demographics imported from an LIS using the “English (Australia)” 

setting: 

 

 
 

Below is an example of a non-Latin based script (Korean) being utilized in the QuickScan Touch plus 

software via Windows’ Beta UTF-8 support. 
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Appendix I – Epson V850 Scanner Upgrade 
If QuickScan Touch plus client uses Epson Perfection V850 Pro scanner, a configuration file will need to be 
replaced in the QST plus program files. Follow the steps below for specific instructions: 
 

1. Insert the installation USB flash drive into the appropriate QST plus client PC. 

2. Copy the “Epson Perfection V850.Scanner.TDF” file from the flash drive (8PF68102). 

3. Navigate to “C:\Program Files (x86)\Helena Laboratories\QuickScan Touch plus\Scanners”, and paste 

the copied file. 

4. Select the “Epson Perfection V800.Scanner.TDF” file from the open folder, and copy it to another 

location as a backup. 

5. Delete the “Epson Perfection V800.Scanner.TDF” file from the Program Files folder. 

6. Close any open folders, and launch QuickScan Touch plus. 
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Appendix J – Verification of .NET Framework Installation 

1. Connect to the internet before changing .NET framework options to ensure proper download and 

installation.   

2. Ensure IIS selections for .NET options are as pictured in Appendix B 

3. Open the Windows Control Panel and click “Programs and Features”. 

4. Make sure Microsoft .NET Framework 4.5 or above exists in the list. 

               
 

5. If not available, download and install the latest .NET Framework 4.8 from Microsoft’s official site: 

https://dotnet.microsoft.com/en-us/download/dotnet-framework/net48 

Appendix K – Updating the software to most recent version from all 
previous versions 
 
Notes before beginning:  

 All clients must be logged off (no longer accessing the database) before the updating process begins. 
This includes all pathologist client systems which might remotely access the system.  

 All Helena software must be updated to the same release version. Mixing old and new software 
versions on the same network is not supported. Be sure to update QST+ on each client computer 
before opening the program once the update process has begun.  

 Upon completion of the update, the following versions should be in use: 

QuickScan Touch plus 2.4.1.0 

Myeloma System Server (MSS) 1.4.0.0 

Myeloma MSAC 1.0.0.0 

QSTplusbackup 2.0.3.0 

 
For QST+ systems using version 2.0.2.0 and beyond: 

1. Update the Backup program 

 From Programs and Features in the Control Panel, uninstall the QSTplusbackup program. 

 Delete the recurring task to run the QSTplusbackup program in Windows Task Scheduler. 

https://dotnet.microsoft.com/en-us/download/dotnet-framework/net48
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 Install the new version of the QSTplusbackup program using the steps under Installation in 
Database Backup Software section.   

 Perform a Database backup using the steps under Database backup in Database Backup 
Software section.   

 Automate database backup using the steps under Automation of backup in Database Backup 
Software section.   

2. Update QuickScan Touch plus client 

 From most recent version (2.3.2.0) 
a) Perform a database backup using the steps under Database backup in Database Backup 

Software section.   
b) Uninstall ONLY the QuickScan Touch plus software program using the step 3 in Existing 

Software Uninstallation section.  
c) Install ONLY the QuickScan Touch plus software using the section QuickScan Touch 

plus Client Installation. 
d) Log in to check function and database connectivity. 
e) If updating a SPIFE Nexus unit, be sure to perform scanner check detailed in 8R500336, 

Appendix A. 

 For all other versions (2.0.2.0, 2.1.4.0, and 2.2.2.0) 
a) Perform a database backup using the steps in Database backup in Database Backup 

Software section.   
b) Uninstall the Myeloma System Server program and QuickScan Touch plus program 

using the steps 1 and 3 of Existing Software Uninstallation section.  
c) Install MSS updated program using the steps in section MSS Installation. 
d) Check MSAC configuration by following the steps in section MSAC Configuration. 
e) Install the QuickScan Touch plus software using the section QuickScan Touch plus 

Client Installation. 
f) Log in to check function and database connectivity. 

 
For Legacy systems (versions 1.3.9.0 and before): 

 If using a version before 1.3.9.0, update to 1.3.9.0 before proceeding. Clients utilizing these versions 
will not be able to update on their current version of Windows; QuickScan Touch plus requires 
Windows 10.  

 On the 1.3.9.0 system, copy the Setup folder from C:\Program Data\Helena Laboratories\QuickScan 
Touch. 

 Copy the Worklists folder from C:\Program Data\Helena Laboratories\ QuickScan Touch. 

 Copy all Report types in case they are not able to import.  

 Copy the QC files using the steps 1 in section QC Scans Import. 

 On a Windows 10 system, follow the workflow outlined in section Legacy import to bring over the 
legacy data into the newest QuickScan Touch plus version.  
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